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Abstract: The intense competition in today's industrial era demands more effective and efficient human resources. While contract 

employees are a strategy for companies to reduce labor costs, these employees often feel burdened by the uncertainty of their career 

paths. Therefore, companies need to focus on the job satisfaction of contract employees, as this is a key factor in boosting their 

morale, discipline, and performance, which in turn helps achieve company goals. Given that work motivation is a significant factor 

in performance, this research aims to determine the influence of the contract work system and work motivation on the performance 

of PT. Busana Indah Global. The study's sample consists of active contract technical employees, selected through purposive 

sampling. The author used a questionnaire with a Likert scale to collect data. This research employs a quantitative method, requiring 

data analysis using validity tests, reliability tests, and multiple linear regression. 
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PENDAHULUAN 

Dalam era globalisasi ini, Indonesia sebagai 

salah satu contoh negara yang sedang 

berkembang akan menghadapi tantangan 

yang berat. Hal ini terjadi karena dalam era 

ini negara-negara berkembang berhadapan 

secara langsung dengan negara-negara maju 

yang memiliki keunggulan hampir di segala 

aspek. Mulai dari teknologi, modal dan 

sumber daya manusia. Ketiga aspek tersebut 

mempunyai arti yang sangat penting 

khususnya sumber daya manusia.  

 

Sumber Daya Manusia (SDM) dipandang 

sebagai aset organisasi yang sangat penting, 

karena manusia merupakan sumber daya 

yang dinamis dan selalu dibutuhkan dalam 

proses produksi barang maupun jasa. 

Mengingat bahwa faktor manusia sangat 

dibutuhkan dalam perusahaan maka 

muncul suatu ilmu manajemen yang 

mempelajari masalah-masalah 

ketenagakerjaan atau kepegawaian yang 

disebut Manajemen Sumber Daya Manusia 

(MSDM) yang berimbas pada tingginya 

standar untuk menjadi seorang karyawan 

dan tingkat pengangguran yang tinggi turut 

menjadi andil semakin ketatnya persaingan 

pekerjaan di berbagai  perusahaan. Jumlah 

penawaran tenaga kerja dan jumlah 

permintaan tenaga kerja yang tidak 

seimbang membuat perusahaan leluasa 

untuk memilih dan memilah bahkan 

mengganti tenaga kerja. Hal ini yang 

menjadikan persaingan antara karyawan 

sehingga karyawan melupakan hak wajar 

yang harus didapat demi mendapatkan 

pekerjaan. Bersamaan dengan itu muncul 

Undang-Undang Ketenaga Kerjaan (UUK) 

yang menyangkut tentang kerja kontrak. 

Setelah disahkan UU No.13 tahun 2003 

banyak perusahaan yang menerapkan 

sistem kerja kontrak di perusahaan masing-

masing. 

 

Dalam hal ini, Indonesia telah mengatur 

tentang sistem ketenaga kerjaan yang 

dihimpun dalam UUK No.13 tahun 2013 

termasuk sistem kerja kontrak. Dalam UU 

tersebut dijelaskan bahwa sistem kerja 

kontrak adalah perjanjian antara 

pekerja/buruh dengan pengusaha atau 

pemberi kerja yang memuat syarat-syarat 

kerja, hak, dan kewajiban para kerja waktu 

tertentu yang didasari atas suatu perjanjian 

atau kontrak dapat juga disebut dengan 

Perjanjian Kerja Waktu Tertentu (PKWT). 

 

Setelah adanya UUK tersebut banyak 

perusahaan di Indonesia yang 

menggunakan sistem kerja kontrak dengan 

berbagai alasan, salah satunya agar mampu 

meningkatkan produktifitas perusahaan, 

serta agar mampu meningkatkan kinerja 

perusahaannya secara efektif dan efisien 

dengan memperkerjakan karyawan 

seminimal mungkin untuk memberi 

kontribusi semaksimal mungkin. 

 

Selaras dengan penjelasan dan alasan diatas, 

salah satu perusahaan yang menerapkan 

sistem tersebut terletak di daerah Kabupaten 

Sukabumi tepatnya di Kecamatan Cibadak 

yaitu PT. Busana Indah Global. Perusahaan 

tersebut telah menerapkan sistem ini sejak 

awal berdiri ketika awal berdirinya 

perusahaan ini mengangkat sistem 

karyawan tetap tidak hanya sistem kontrak. 

namun,seiring berjalannya waktu hingga 

pada tahun 2017 PT. Busana Indah Global 

tidak lagi mengangkat karyawan tetap, dan 

hal ini menyebabkan karyawan tetap tidak 

bertambah.tidak hanya itu  Sistem kontrak 

kerja ini tidak dalam waktu yang lama hanya 

dalam hitungan 1-3 bulan saja. berdasarkan 
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permasalahan tersebut, maka kondisi 

jumlah seluruh karyawan PT. Busana Indah 

Global pada tahun saat ini di Tahun 2023 

mempunyai jumlah karyawan sebanyak 

3.278 orang dengan rincian seperti yang 

tercantum pada tabel 1. 

 

Tabel 1. Jumlah Karyawan PT. Busana Indah Global 

No Departemen 
Jumlah 

Karyawan Tetap 

Jumlah 

Karyawan 

Kontrak 

Total 

1. HRD 1 3 4 

2. Staff Office 3 32 35 

3. Gudang 1 60 61 

4.  Cutting 2 150 152 

5. Sewing 10 2.500 2.510 

6. Quality Control   252 252 

7. Packing 2 200 202 

8. Umum  50 50 

9. Security  12 12 

Total 21 3.257 3.278 

 Sumber: bagian HRD 

 

Dengan kondisi yang terjadi karena 

perubahan status kepegawaian dari 

perusahaan menyebabkan adanya keluhan 

dari para karyawan karena mereka hanya 

bisa menjadi karyawan kontrak tidak bisa 

menjadi karyawan tetap dan kontrak yang di 

berikan pun tidak dalam jangka waktu lama 

yang menjadikan  karyawan bekerja dengan 

sewajarnya karena karyawan mengganggap 

tidak ada suatu hal yang harus di 

perjuangkan dan jenjang karir yang tidak 

jelas sehingga kinerja karyawan yang di 

hasilkan pun tidak maksimal. Berikut 

rincian pendapatan hasil kerja pada 6 bulan 

terakhir pada tabel 2. 

 
Tabel 2. Jumlah Hasil Kerja Karyawan PT. Busana Indah Global 

Sumber: Manajemen Operasional  
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Tabel 2 merupakan target produksi dan 

realisasi di PT. Busana Indah. Dari data 

tersebut menunjukkan ketidakstabilan 

pencapaian target produksi, ini 

menggambarkan bahwa kinerja karyawan 

dari segi kuantitas pada PT. Busana Indah 

Global naik turun. Target yang harus di 

capai tidak selalu terpenuhi, di karenakan 

tidak stabilnya produksi. 

 

Hal lain yang mempenggaruhi kinerja 

karyawan adalah motivasi kerja 

dikarenakan sumber daya manusia 

merupakan satu-satunya yang memiliki 

akal, perasaan, keinginan, pengetahuan, 

dorongan, daya dan karya seorang 

karyawan merupakan investasi paling 

berharga didalam organisasi yang menjadi 

aset utama yang bernilai dan harus diakui 

akan keberadaannya sebagai kunci utama 

bahkan menjadi faktor penentu atas 

keberhasilan suatu organisasi dalam 

menjalankan visi, misi dan tujuan 

oraganisasi. Itulah sebabnya mengapa peran 

manusia sangat besar pengaruhnya sebagai 

motor penggerak (driving force) dan sebagai 

agen perubahan (Agen Of Change). 

 

Tujuan organisasi dapat diraih semaksimal 

mungkin apabila didukung dengan kinerja 

yang baik dari para karyawan. Untuk 

mendapatkan kinerja yang baik dari 

karyawan maka harus diupayakan 

pengarahan yang terstruktur dan efektif. 

Perusahaan dalam upaya menggerakan para 

karyawannya agar mau bekerja lebih 

produktif lagi sesuai dengan tujuan 

perusahaan yang telah ditetapkan. Motivasi 

dapat dipandang sebagai perubahan energi 

dalam diri seseorang yang ditandai dengan 

munculnya perasaan (feeling), dan didahului 

dengan tanggapan terhadap adanya tujuan. 

jadi motivasi dalam hal ini sebenarnya 

merupakan respons dari suatu aksi tujuan 

ini menyangkut soal kebutuhan dapat 

dikatakan bahwa tidak akan ada suatu 

motivasi apabila tidak dirasakan adanya 

suatu kebutuhan. Oleh karena, itu untuk 

mencapai kinerja yang diharapkan 

perusahaan dibutuhkan motivasi pada 

karyawan, motivasi tersebut dapat berupa 

bonus. 

 

TINJAUAN PUSTAKA 

Motivasi Kerja 

Motivasi adalah serangkaian sikap dan nilai-

nilai yang mempengaruhi individu untuk 

mencapai hal yang spesifik sesuai dengan 

tujuan individu. Sikap dan nilai tersebut 

merupakan suatu kekuatan untuk 

mendorong individu bertingkah laku dalam 

mencapai tujuan. Dorongan tersebut terdiri 

dari dua komponen, yaitu: arah perilaku 

kerja (kerja untuk mencapai tujuan), dan 

kekuatan perilaku. 

 

Motivasi meliputi perasaan unik, pikiran 

dan pengalaman masa lalu yang merupakan 

bagian dari hubungan internal dan eksternal 

perusahaan. Motivasi adalah pemberian 

daya penggerak yang menciptakan 

kegairahan kerja seseorang agar mereka 

mau bekerja dengan segala daya upayanya 

untuk mencapai kepuasan, menurut 

Hasibuan (2007: 95). Ishak dan Hendri 

(2003:12) suatu hal pokok yang menjadi 

dorongan sering kali diartikan pula sebagai 

faktor pendorong perilaku seseorang. 

Menurut Robbins (2008:222) motivasi 

sebagai proses yang menjelaskan intensitas, 

arah dan ketekunan seseorang individu 

untuk mencapai tujuan. Berdasarkan 

pendapat tersebut dapat disimpulkan 

bahwa: 

1. Motivasi kerja merupakan bagian yang 

urgen dalam suatu organisasi yang 
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berfungsi sebagai alat pencapaian 

tujuan atau sasaran yang ingin dicapai. 

2. Motivasi kerja mengandung dua tujuan 

utama dalam diri individu yaitu untuk 

memenuhi kebutuhan atau keinginan 

pribadi dan tujuan organisasi 

3. Motivasi kerja yang diberikan kepada 

seseorang hanya efektif manakala di 

dalam diri seseorang itu memiliki 

kepercayaan atau keyakinan untuk 

maju dan berhasil dalam organisasi.  

 

Motivasi dibedakan menjadi dua, yaitu: 

1. Motivasi Intrinsik 

Motivasi intrinsik adalah motivasi yang 

berasal dari perasaan puas dalam 

melaksanakan pekerjaan itu sendiri. Ia 

merupakan bagian langsung dari 

kandungan kerja. Oleh sebab itu, 

menurut Siagian (2004:139) motivasi 

intrinsik bersumber dari dalam 

individu. Motivasi intrinsik jika 

dihubungkan dengan hirarki kebutuhan 

manusia, maka menyangkut kebutuhan 

tingkat lebih tinggi (higher level needs) 

yaitu esteem needs dan self 

actualization needs. Nilai kerja intrinsik 

adalah nilai kerja yang berhubungan 

dengan pekerjaan itu sendiri. Nilai kerja 

intrinsik meliputi ketertarikan terhadap 

pekerjaan, tertantang pada pekerjaan, 

belajar hal baru, membuat kontribusi 

penting, memanfaatkan potensi kerja 

sepenuhnya, tanggung jawab, otonomi 

dan kreatif. Motivasi intrinsik ada untuk 

posisi ketertarikan dan ketertantangan 

dalam pekerjaan. 

2. Motivasi Ekstrinsik 

Motivasi Ekstrinsik adalah motivasi 

yang ada kaitannya dengan imbalan 

yang diterima seseorang sesudah 

melakukan pekerjaan. Imbalan ini dapat 

berupa 4 promosi, hubungan pribadi, 

gaji, upah, serta tunjangan, sehingga 

motivasi ekstinsik ini berasal dari luar 

pribadi atau individu. Manullang (2001: 

119) menyatakan bahwa jika 

perusahaan menyediakan kondisi-

kondisi kerja, upah, tunjangan, atau 

keselamatan kerja yang tidak 

mencukupi, maka ia akan mendapat 

kesulitan dalam menarik karyawan-

karyawan yang baik, dan perputaran, 

kemangkiran serta keluhan-keluhan 

akan meningkat. 

 

Sistem Kontrak 

Istilah perjanjian atau kontrak merupakan 

terjemahan dari bahasa inggris yaitu 

contract law, sedangkan dalam bahasa 

Belanda disebut overeenscomsrecht. 

Menurut Salim H.S, perjanjian atau kontrak 

kerja adalah suatu peristiwa dimana seorang 

berjanji kepada seseorang yang lain atau 

dimana dua orang itu saling berjanji untuk 

melaksanakan suatu hal,bentuk perjanjian 

itu berupa suatu rangkaian perkataan yang 

mengandung janji-janji atau kesanggupan 

yang diucapkan atau ditulis. Kontrak atau 

kesanggupan yang diucapkan atau ditulis. 

Kontrak atau persetujuan (contract or 

agreenment) yang diatur dalam Buku III bab 

kedua KUHPerdata (BW) Indonesia, sama 

saja dengan pengertian perjanjian. Perjanjian 

atau persetujuan adalah suatu perbuatan 

dengan mana seseorang atau lebih 

meningkatkan dirinya terhadap satu orang 

atau lebih. Menurut Kamus Besar Bahasa 

Indonesia kontrak adalah berkenaan dengan 

sewa menyewa sesuatu dengan dasar 

perjanjian yang disepakati kedua belah 

pihak dalam waktu tertentu, perjanjian 

dalam perdagangan. Kontrak kerja adalah 

suatu perjanjian antara pekerja dan 

pengusaha secara lisan dan atau tulisan, baik 

untuk waktu tertentu maupun untuk waktu 
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tidak tertentu yang memuat syarat-syarat 

kerja, hak dan kewajiban karena kontrak 

kerja adalah dokumen yang memiliki 

kekuatan untuk mengelola hubungan 

tenaga kerja dengan pemberi kerja. 

Dokumen ini berisi tentang identitas kedua 

belah pihak, hak dan kewajiban, serta 

aturan-aturan terkait pekerjaan yang akan 

dilaksanakan. Ketika sebuah dokumen 

perjanjian kerja disepakati oleh kedua belah 

pihak, maka harus ada bukti kesepakatan 

yang sah. Baik itu berupa tanda tangan, cap 

sidik jari, maupun stempel yang sah sesuai 

hukum. Sering juga disebut sebagai 

perjanjian kerja, dokumen ini memiliki 

beberapa jenis yang juga memiliki fungsi 

berbeda. 

 

Kontrak Kerja/Perjanjian Kerja menurut 

Undang-Undang No.13/2003 tentang 

Ketenagakerjaan adalah perjanjian antara 

pekerja/buruh dengan pengusaha atau 

pemberi kerja yang memuat syarat syarat 

kerja, hak, dan kewajiban para pihak. Pada 

dasarnya untuk menyatakan suatu kontrak 

kerja/perjanjian kerja dianggap sah atau 

tidak maka wajib untuk memperhatikan 

ketentuan dalam pasal 1320 Kitab Undang-

Undang Hukum Perdata (KUH Perdata) 

yang menyatakan bahwa: Supaya terjadi 

persetujuan yang sah, perlu dipenuhi empat 

syarat, yaitu: 

1. Kesepakatan mereka yang mengikatkan 

dirinya 

2. Kecakapan untuk membuat suatu 

perikatan 

3. Suatu pokok persoalan tertentu 

4. Suatu sebab yang tidak terlarang 

 

Pasal 52 ayat 1 UU No. 13 Tahun 2003 

tentang Ketenagakerjaan juga menegaskan 

bahwa: Perjanjian kerja dibuat atas dasar: 

1. Kesepakatan kedua belah pihak 

2. Kemampuan atau kecakapan 

melakukan perbuatan hukum 

3. Adanya pekerjaan yang diperjanjikan 

4. Pekerjaan yang diperjanjikan tidak 

bertentangan dengan ketertiban umum, 

kesusilaan, peraturan perundang-

undangan yang berlaku. 

 

Jenis Kontrak Kerja 

Berikut penjelasan mengenai masing-

masing jenis kontrak kerja. 

1. PKWTT 

Kontrak kerja Perjanjian Kerja Waktu 

Tidak Tertentu (PKWTT) adalah 

kontrak yang dibuat untuk karyawan 

atau tenaga kerja tetap. Dikatakan 

sebagai “Waktu Tidak Tertentu” karena 

lamanya bekerja orang tersebut tidak 

ditentukan dan biasanya ada aturan 

pensiun atau sejenisnya. Pada 

praktiknya, dokumen perjanjian kerja 

untuk PKWTT terkadang tidak dibuat 

dalam bentuk cetak dan hanya 

disampaikan secara lisan. Meskipun 

begitu, perusahaan harus membuat 

surat pengangkatan kerja bagi tenaga 

kerja tersebut setelah lulus masa 

percobaan selama 3 bulan. 

2. PKWT 

Selanjutnya adalah kontrak kerja 

Perjanjian Kerja Waktu Tertentu 

(PKWT) yang dibuat untuk karyawan 

tidak tetap. Bagi karyawan dengan jenis 

kontrak ini tidak ada masa percobaan 

dan waktu yang ditetapkan maksimal 1 

tahun dengan perpanjangan maskimal 3 

kali. dalam kebijakan tertentu, masa 

kerja ini juga dapat disesuaikan dengan 

selesainya pekerjaan. Faktor terpenting 

dari jenis kontrak ini adalah adanya 

bukti fisik kontrak beserta hal-hal yang 

membuatnya sah secara hukum seperti 
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materai dan tanda tangan yang 

bersangkutan. 

3. Part Time 

Kemudian ada juga jenis kontrak kerja 

bagi tenaga kerja paruh waktu atau part 

time. Meskipun tenaga kerja ini bekerja 

dengan waktu kurang dari jam kerja 

normalnya, yaitu 8 jam. Pekerja paruh 

waktu biasanya tidak terikat pasal 

perjanjian sekuat PKWT, namun akan 

jauh lebih baik jika hak dan kewajiban 

kedua belah pihak dituangkan dalam 

dokumen tertulis. 

4. Outsourcing 

Jenis terakhir adalah kontrak kerja bagi 

tenaga kerja outsourcing yang ikut 

dengan pihak agensi atau pemborong 

tertentu. Sesuai dengan jenisnya, 

perjanjian kerja ini dilakukan oleh 

perusahaan dengan penyedia tenaga 

kerja. Biasanya jenis ini diterapkan 

untuk perusahaan yang membutuhkan 

tenaga kerja dalam jumlah besar seperti 

pabrik. Kemudian nantinya perusahaan 

penyedia tenaga kerja ini akan membuat 

kontrak PKWT terpisah dengan tenaga 

kerja tersebut. 

 

Kinerja 

Terdapat beberapa pendapat mengenai 

pengertian kinerja. Menurut Moeheriono 

(2012:95), kinerja atau performance 

merupakan sebuah penggambaran 

mengenai tingkat pencapaian pelaksanaan 

suatu program kegiatan atau kebijakan 

dalam mewujudkan sasaran, tujuan, visi, 

dan misi organisasi yang dituangkan dalam 

suatu perencanaan strategis suatu 

organisasi. Kinerja merupakan hal yang 

sangat penting dan harus diperhatikan oleh 

seluruh manajemen, baik pada tingkatan 

organisasi kecil maupun besar. Hasil kerja 

yang dicapai oleh organisasi atau karyawan 

adalah bentuk pertanggungjawaban kepada 

organisasi dan publik. Kinerja dalam 

menjalankan fungsinya tidak berdiri sendiri, 

melainkan selalu berhubungan dengan 

kepuasan kerja karyawan,kontrak kerja 

yang di berikan dan tingkat besaran 

imbalannya, serta dipengaruhi oleh 

keterampilan, kemampuan dan sifat-sifat 

individu. 

 

Kinerja juga merupakan hasil dari 

pelaksanaan suatu pekerjaan baik bersifat 

fisik/material maupun non fisik/non 

material. pengertian kinerja pegawai 

merujuk kepada kemampuan pegawai 

dalam melaksanakan seluruh tugas-tugas 

yang menjadi tanggung jawabnya. Tugas-

tugas tersebut biasanya berdasarkan 

indikator-indikator keberhasilan yang 

sudah ditetapkan. Sebagai hasilnya akan 

diketahui bahwa seseorang pegawai masuk 

dalam tingkatan kinerja tertentu. 

Tingkatanya dapat bermacam istilah. 

Kinerja pegawai dapat dikelompokan 

kedalam: tingkatan kinerja tinggi, menengah 

atau rendah, dan dapat juga dikelompokan 

melalui target, sesuai atau di bawah target. 

Berangkat dari hal-hal tersebut, kinerja 

dimaknai sebagai keseluruhan “unjuk kerja” 

dari seorang pegawai. Pengertian kinerja 

dalam kamus Bahasa Indonesia, dikatakan 

bahwa kinerja memiliki arti: sesuatu yang 

dicapai, prestasi yang diperlihatkan, dan 

kemampuan kerja. Selain itu, kinerja 

merupakan perilaku nyata yang 

ditampilkan setiap orang sebagai prestasi 

kerja yang dihasilkan oleh pegawai sesuai 

dengan perannya dalam perusahaan. Mutu 

kinerja meliputi: ketepatan waktu, 

keterampilan, ketelitian, dan kerapian. 

Kuantitas kerja merupakan keluaran yang 

tidak hanya berupa tugas-tugas reguler, 

tetapi juga tugas-tugas ekstra atau 
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mendesak. ketangguhan meliputi: 

kedisiplinan, inisiatif, loyalitas, ketaatan 

pada peraturan yang ditetapkan. Menurut 

Armstrong dan Baron dalam Abdullah 

(2014) kinerja merupakan hasil pekerjaan 

yang mempunyai hubungan kuat dengan 

tujuan strategis organisasi, kepuasan 

konsumen, dan memberikan kontribusi 

pada ekonomi. 

 

Berdasarkan pendapat para ahli maka dapat 

ditarik kesimpulan kinerja pegawai adalah 

hasil kerja secara kuantitas dan kualitas yang 

dicapai oleh seorang pegawai dimana kerja 

tersebut dapat ditunjukan buktinya secara 

konkrit dan dapat diukur (dibandingkan 

dengan standar yang telah ditentukan). 

Kinerja dikatakan baik dan sukses jika 

tujuan yang diinginkan dapat dicapai 

dengan baik. Efisiensi dan efektivitas 

merupakan dua aspek penting dalam 

menilai suatu kinerja. Efisiensi adalah 

perbandingan antara hasil yang dicapai 

dengan usaha yang dikeluarkan, sedangkan 

efektivitas adalah perbandingan antara hasil 

yang dicapai dengan hasil yang diharapkan. 

kedalam faktor-faktor intrinsik dalam 

pekerjaan sebagai berikut: 

1. Tuntutan Fisik 

Kondisi kerja tertentu dapat 

menghasilkan prestasi kerja yang 

optimal disamping dampaknya 

terhadap kinerja pegawai, kondisi fisik 

berdampak pula terhadap kesehatan 

mental seorang tenaga kerja. Kondisi 

fisik pekerja mempunyai pengaruh 

terhadap kondisi faal dan psikologi 

seseorang. Dalam hal ini bahwa kondisi 

kesehatan pegawai harus tetap dalam 

keadaan sehat saat melakukan 

pekerjaan, selain istirahat yang cukup 

juga dengan dukungan sarana tempat 

kerja yang nyaman dan memadai. 

2. Tuntutan Tugas 

Kerja shift atau kerja malam sering kali 

menyebabkan kelelahan bagi para 

pegawai akibat dari beban kerja yang 

berlebihan. Beban kerja berlebihan dan 

beban kerja terlalu sedikit dapat 

berpengaruh terhadap kinerja pegawai. 

Beban kerja dapat dibedakan menjadi 

dua kategori, yaitu: 

a. Beban kerja terlalu banyak atau 

sedikit kuantitatif yang timbul 

akibat dari tugas. Tugas yang terlalu 

banyak/sedikit diberikan kepada 

tenaga kerja untuk diselesaikan 

dalam waktu tertentu 

b. Beban kerja berlebihan/terlalu 

sedikit kualitatif yaitu jika orang 

merasa tidak mampu untuk 

melaksanakan suatu tugas atau 

melaksanakan tugas tidak 

menggunakan keterampilan dan 

atau potensi dari tenaga kerja. Beban 

kerja terlalu sedikit dapat 

menyebabkan kurang adanya 

rangsangan akan mengarah ke 

semangat dan motivasi yang rendah 

untuk kerja, karena pegawai akan 

merasa bahwa dia tidak maju-maju 

dan merasa tidak berdaya untuk 

memperlihatkan bakat dan 

keterampilannya (Sutherland & 

Cooper) dalam Munandar, dalam 

Nofitasari, 2015). 
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Kerangka Pemikiran  

 
Gambar 1. Kerangka Pemikiran

Variabel independen merupakan variabel 

yang mempengaruhi atau menjadi sebab 

perubahannya atau timbul variabel 

dependen atau terikat. Dalam penelitian ini 

terdapat 2 variabel bebas, yaitu Kontrak 

Kerja (X1) dan Motivasi Kerja (X2). 

 

Variabel dependen merupakan variabel 

yang dipengaruhi atau yang menjadi akibat, 

karena adanya variabel independen. Dalam 

penelitian ini yang menjadi variabel terikat 

adalah Kinerja (Y). 

 

Hipotesis  

Peneliti dapat mengambil kesimpulan 

bahwa hipotesis merupakan asumsi 

sementara/praduga dalam penelitian 

berdasarkan permasalahan yang 

teridentifikasi di atas, kemudian dengan 

memperhatikan teori-teori yang ada saat ini 

dan berdasarkan kerangka kerja di atas: 

• H1: Motivasi Kerja berpengaruh secara 

Parsial terhadap kinerja karyawan pada 

PT. Busana Indah Global 

• H2: Kontrak Kerja berpengaruh secara 

Parsial terhadap kinerja karyawan pada 

PT. Busana Indah Global 

 

METODE PENELITIAN 

Profil Perusahaan  

PT. Busana Indah Global merupakan bagian 

dari Molax Group yaitu  perusahaan yang 

bergerak di bidang industri garmen yaitu 

memproduksi barang jadi, dengan  jumlah 

karyawan 3.278 orang, dengan kapasitas 

produksi 1.500.000 pcs/bulan, pakaian yang  

diprosuksi mulai dari pakaian untuk bayi 

balita, batita, balit, anak-anak hingga dewasa 

dari  jaket baby boys/girl, t-shirt, ladie 

blouse, pants, dress, top dan bottom yang 

nantinya akan di  ekspor ke luar negeri, 

seperti Jepang, Amerika, Arab, Cina Korea 

dan negara lainnya. PT. Busana Indah Global 

berdiri pada Oktober 2006 yang belokasi di 

Jl. Cireundeu Karang Tengah. Manajemen 

team terdiri dari profesional Korea dan & 

Indonesia  yang mempunyai pengalaman 

kurang lebih 20 tahun di garment industri. 

Pada masa awal  kepemimpinannya PT. 

Busana Indah Global dipimpin oleh Mr. 

Back sampai tahun 2009, kemudian 

digantikan  oleh Mr. Noh sampai tahun 2011, 

dan dipimpin oleh Mr. Moon sampai 2014, 

kemudian  digantikan oleh Mr. Shin sampai 

tahun 2018, kemudian digantikan oleh Mr. 

Allan Hscheo  sampai sekarang.  Pada 

awalnya PT. Busana Indah Global hanya 

memiliki satu factory yaitu factory 1. Namun 

seiring  dengan perkembangan produksi 

yang terus meningkat, maka pada tahun 

2010 dibangun  factory 2 untuk memenuhi 

kebutuhan ekspor. Dan pada bulan Mei 2011 

PT. Busana Indah Global bekerja  sama 

dengan Brand Adidas untuk memproduksi 

pakaian olahraga, dan dibangunlah factory 3  

khusus untuk brand Adidas. Di tahun 2023 

ini hanya tersisa 2 factory yang yang masih  

beroperasi yaitu factory 1 dan 2. 
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Visi : “To Achieve Long Term Sustainable 

Quality Level Through Continous 

Improvement“ (untuk mencapai produk yang 

berkualitas dalam jangka panjang melalui 

perbaikan  secara berkesinambungan). 

 

Misi :“ Our Goal To Meet Our Costumer 

Satisfaction By Providing Better  Quality 

Product ” (Mencapai Tujuan Kita Demi 

Memuaskan Para Pelanggan Dengan 

Menyiapkan Produk  Yang Berkualitas). 

 

Waktu Penelitian  

Penelitian ini dilakukan di PT. Busana Indah 

Global, Jawa Barat dengan kurun waktu 

selama empat bulan. penelitian ini di mulai 

pada 4 April 2023. Teknik pengambilan data 

yang dilakukan pada penelitian ini dengan 

menggunakan metode deskriptif kualitatif 

yang mana metode penelitian ini bertujuan 

untuk menggambarkan secara utuh dan 

mendalam mengenai kejadian atau 

fenomena yang sedang diteliti oleh peneliti. 

 

Desain Penelitian  

Jenis penelitian ini menggunakan penelitian 

kuantitatif. Dalam penelitian kuantitatif ini 

banyak digunakan metode penelitian survei 

yang merupakan penelitian dengan 

menggunakan kuesioner sebagai sarana 

pengumpulan data. Kuesioner disebarkan 

kepada responden untuk kemudian 

responnya dianalisis oleh peneliti (fenia, 

2026 et.al., n.d.) 

 

Selain itu penelitian kuantitatif lebih 

ditekankan pada aspek pengukuran secara 

obyektif terhadap responden. Biasanya 

peneliti akan mengambil sampel dari 

sekelompok responden untuk kemudian 

mewakili seluruhnya. Maksudnya 

responden sebagai sampel akan mewakili 

kategori keseluruhan orang sehingga 

dengan adanya sekelompok responden 

sebagai sampel, peneliti tidak perlu meneliti 

semua populasi yang ada.  

 

Definisi Operasional Variabel  

Definisi Operasional Variabel 

merupakan penjabaran dari variabel-

variabel penelitian, dimensi, dan indikator 

yang digunakan untuk mengukur variabel 

tersebut. Penelitian ini memiliki variabel 

independent dan variabel dependen. Berikut 

merupakan definisi variabel tersebut: 

1. Variabel Independent/Bebas (X1) 

Variabel Independent adalah suatu 

variabel bebas dimana keberadaannya 

tidak dipengaruhi oleh faktor-faktor 

yang lain, variabel ini merupakan faktor 

penyebab yang akan mempengaruhi 

variabel lain, dalam penelitian ini 

variabel independentnya adalah Sistem 

Kontrak Kerja. 

 

Sistem kontrak kerja adalah suatu 

perjanjian yang terjadi antara pekerja 

dan perusahaan (atau pemilik usaha), 

baik dalam bentuk tertulis maupun 

lisan, yang memuat poin-poin mengenai 

hak dan kewajiban dari kedua belah 

pihak sesuai dengan peraturan 

perundang-undangan yang berlaku. 

2. Variabel Independent/Bebas (X2) 

Variabel Independent adalah suatu 

variabel bebas dimana keberadaannya 

tidak dipengaruhi oleh faktor-faktor 

yang lain, variabel ini merupakan faktor 

penyebab yang akan mempengaruhi 

variabel lain, dalam penelitian ini 

variabel independentnya adalah 

Motivasi Kerja. 

 

Motivasi kerja merupakan stimulus 

atau rangsangan bagi setiap pegawai 

untuk bekerja dalam menjalankan 
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tugasnya. Dengan motivasi yang baik 

maka para pegawai akan merasa senang 

dan bersemangat dalam bekerja 

sehingga mengakibatkan 

perkembangan dan pertumbuhan yang 

signifikan pada diri organisasi. 

3. Variabel Dependent/Terikat (Y) 

Variabel Dependent adalah variabel 

yang dipengaruhi oleh variabel lain. 

Dalam penelitian ini variabel 

dependentnya adalah Kinerja 

Karyawan.  

 

Kinerja adalah hasil kerja yang dicapai 

oleh seseorang atau kelompok orang 

dalam suatu organisasi, sesuai dengan 

wewenang dan tanggung jawab 

masing-masing dalam rangka upaya 

mencapai tujuan organisasi 

bersangkutan, secara legal tidak 

melanggar hukum dan sesuai dengan 

moral maupun etika, Mathis dan 

Jackson (2013). 

 

Skala Likert/Pengukuran  

Skala Likert adalah skala yang digunakan 

untuk mengukur persepsi, sikap atau 

pendapat seseorang atau kelompok 

mengenai sebuah peristiwa atau fenomena 

sosial, berdasarkan definisi operasional yang 

ditetapkan oleh peneliti. 

 

Kuesioner penelitian ini disebarkan kepada 

karyawan PT. Busana Indah Global agar 

dapat memperoleh data yang tepat dan 

sesuai. Oleh karena itu dibuat pertanyaan 

terstuktur dengan alat ukur skala likert. 

 

Tabel 3. Skala Likert 

1. STS = Sangat Tidak Setuju Dengan Nilai 1 

2. TS = Tidak Setuju Dengan Nilai 2 

3. N = Netral Dengan Nilai 3 

4. S = Setuju Setuju Dengan Nilai 4 

5. SS = Sangat Setuju Dengan Nilai 5 

Berdasarkan uraian di atas, di bawah ini 

contoh menghitung dengan skala Likert, 

yaitu:  

STS: Hasil yang di dapat 10 = 10 x 1 = 10 

TS: Hasil yang di dapat 10 = 10 x 2 = 20 

N:  Hasil yang di dapat 13 = 13 x 3 = 39 

S:  Hasil yang di dapat 42 = 42 x 4 = 168 

SS:  Hasil yang di dapat 25 = 25 x 5 = 
125

362
 

 

Jumlah skor ideal untuk seluruh item = nilai 

tertinggi x responden = 5 x 100 = 500 

Jumlah skor yang di peroleh adalah = 362 

Jadi, tingkat persetujuan terhadap sistem 

kerja dan kontrak kerja terhadap kinerja 

yaitu = 362 : 500 x 100% = 72,4% 

 

Populasi dan Sampel  

Populasi dan Sample keduanya merupakan 

dua hal yang saling berkaitan dan tidak 

dapat dipisahkan satu sama lain. 

Sederhananya sampel penelitian dapat 

diartikan sebagai bagian dari populasi dan 

merupakan wakil dari anggota populasi 

yang diteliti. Keduanya menjadi hal yang 

sangat menentukan hasil penelitian karena 

dapat memberikan generalisasi pada hasil 

penelitian yang didapat. 

 

Oleh karenanya, penting sekali untuk dapat 

bersikap cermat dan teliti dalam 
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menentukan besaran populasi dan sampel 

yang akan digunakan. Bahkan hal tersebut 

harus sudah kalian perhatikan dengan 

matang jauh sebelumnya. Berikut ini 

merupakan penjelasan mengenai populasi 

dan sampel oleh para ahli. 

1. Populasi  

Populasi merupakan sebuah data yang 

menjadi perhatian dalam suatu lingkup 

ruang dan waktu yang telah ditentukan. 

(fenia 2016 et al., n.d.). Dalam penelitian 

ini yang menjadi populasi adalah 

karyawan PT. Busana Indah Global 

yang berjumlah 3.278 karyawan. 

2. Sampel  

Sampel merupakan bagian dari sebuah 

populasi, dimana merupakan sebagian 

dari populasi yalng menjadi wakil yang 

akan menjadi target peneliti. (fenia 2016 

et al., n.d.) sampel dalam penelitian ini 

merupakan sebagian dari populalsi 

yalng dialmbil untuk kemudian 

diberikan kuesioner penelitialn oleh 

peneliti. 

 

Pengambilan sampel dilakukan dengan 

cara sistem random sampling. Teknik 

dirasa sesuai dengan penelitian yang 

populasinya merupakan karyawan PT. 

Busana Indah Global. Random sampling 

sendiri merupakan teknik pengambilan 

sampel secara acak dari populasi yang 

ada. Untuk dapat menggunakan teknik 

random sampling ini dibutuhkan 

hitungan untuk menentukan jumlah 

sampel. Dalam pengambilan sampel ini 

penelitian menggunakan rumus slovin 

sebagai berikut:  

𝑛 =
𝑁

1+𝑁𝑒2
  

Keterangan : 

n  = ukuran sample 

N = ukuran populasi 

𝑒2= persen kelonggaran ketidaktelitian 

(10%) 

Diketahui N = 3278 e2 = 10% 

Maka n  = 3278/(1+(3278(0,1)2 ) 

   = 3278/(1+(3278(0,01) 

= 3278/(1+ 32.78) 

= 3278 / 33.78 

= 97,0396684 

= 97 sample yang di 

ambil 

 

Metode Penelitian  

Metode Penelitian yang di gunakan yaitu 

Metode Penelitian kuantitatif, penelitian 

yang didasarkan pada pengumpulan dan 

analisis data berbentuk angka (numerik) 

untuk menjelaskan, memprediksi, dan 

mengontrol fenomena yang 

diminati.Penelitian kuantitatif ini 

menekankan analisisnya pada data-data 

numerikal yang diolah dengan metode 

statistik. Dengan metode kuantitatif akan 

diperoleh signifikasi hubungan antar 

variabel. 

 

Metode Pengumpulan Data  

Metode Pengumpulan Data ini berisi 

pengujian-pengujian data yang diperoleh 

dari hasil jawaban responden yang diterima 

kemudian dianalisis dengan menggunakan 

spss, prosedur analisis dalam penelitian. 

Teknik analisis yang digunakan adalah 

dengan menggunakan pendekatan  

kuantitatif dengan penelitian studi kasus 

yang dipergunakan untuk mengumpulkan, 

mengolah, dan kemudian menyajikan data 

observasi agar pihak lain dapat dengan 

mudah mendapat gambaran mengenai objek 

dari penelitian tersebut. Adapun metode 

analisis yang digunakan yaitu sebagai 

berikut: 
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1. Uji Instrumen Penelitian 

Uji Instrumen Penelitian ini 

menggunakan kuesioner atau angket, 

disampaikan kepada responden untuk 

dapat memberikan pernyataan sesuai 

dengan apa yang dirasakan dan 

dialaminya. Angket 

sebagai instrumen harus memenuhi 

persyaratan utama yaitu Validasi dan 

Reliability.  

2. Uji Validitas 

Uji Validitas digunakan untuk 

mengukur sah atau valid tidaknya suatu 

kuesioner. Suatu kuesioner dikatakan 

valid jika pertanyaan dalam memenuhi 

standar yang sudah ditentukan seperti 

berikut: 

a. Apabila r hitung > r tabel, 

kesimpulannya item koesioner 

tersebut valid 

b. Apabila r hitung < r tabel, 

kesimpulannya item koesioner 

tersebut tidak valid 

 

r hitung adalah nilai yang berada dalam 

kolom, sedangkan r tabel adalah tabel yang 

berisi angka yang digunakan untuk menguji 

berbagai kemungkinan hasil validitas data 

penelitian. 

 

Langkah-langkah pengujian validasi sendiri, 

yaitu:  

Masukan Data → Analyze → Correlate → 

Bivariate → Masukan Seluruh Data  Ke 

Kolom Variabel → Klik Two Failed → Klik 

Flag → Ok 

3. Uji Reabilitas  

Uji Reliabilitas adalah indeks yang 

menunjukan sejauh mana suatu alat 

pengukur dapat dipercaya atau dapat 

diandalkan, (Situmorang, 2014:89). 

Pengujian dilakukan dengan 

menggunakan program SPSS, butir 

pertanyaan yang sudah dinyatakan 

valid dalam uji validitas ditentukan 

reliabilitasnya dengan kriteria sebagai 

berikut (Situmorang, 2014:92): 

a. Jika nilai Cronbach Alpha ≥ 0,8 maka 

reliabilitas sangat baik 

b. Jika nilai 0,7 < Cronbach's Alpha ≥ 

0,8 maka reliabilitas baik 

c. Jika nilai Cronbach's Alpha ≤ 0,7 

maka tidak reliable. 

 

Langkah-langkah perhitungan uji reabilitas, 

yaitu: 

Masukan Data → Sesuaikan Variabel View 

Dengan Judul Penelitian → Analyze → Scale 

→ Reabillity Analisis → Pindahkan Semua 

Item → Ok 

 

Teknik Analisis Data  

Metode Analisis Deskriptif dilakukan dalam 

penelitian ini untuk menganalisis data yang 

telah didapatkan. Metode analisis deskriptif 

ini merupakan suatu kaidah untuk 

merumuskan dan menafsirkan data yang 

ada sehingga memberikan gambaran yang 

jelas dengan cara mengumpulkan, 

menyusun, dan menganalisa data sampai 

diketahuinya gambaran umum dari objek 

yang diteliti. Selain daripada itu, metode 

analisis yang digunakan adalah 

menggunakan uji asumsi klasik, analisis 

regresi linear berganda, uji hipotesis, dan 

koefisien determinan (R2) yang diolah 

melalui bantuan program Software 

Statistical Product and Service Solution 

(SPSS) yang mana sebelumnya telah diuji 

melalui uji validitas dan uji reabilitas. 

Berdasarkan uraian di atas berikut 

merupakan pengertian dari uji asumsi 

klasik, analisis regresi linear berganda, uji 

hipotesis, dan koefisien determinan (R2): 
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1. Uji Asumsi Klasik 

Uji asumsi klasik adalah persyaratan 

statistic yang harus dipenuhi pada 

analisis regresi linear berganda yang 

berbasis ordinary leas square (OLS). 

Sebelum melakukan pengujian 

hipotesis yang diajukan dalam 

penelitian perlu dilakukan pengujian 

asumsi klasik yang meliputi Uji 

Normalitas, Uji Multikolinieritas dan 

Uji Heteroskedastisitas. 

2. Uji Normalitas 

Uji Normalitas bertujuan untuk menguji 

apakah dalam model regresi variabel 

independen dan variabel dependen atau 

keduanya mempunyai distribusi 

normal atau tidak, variabel penggangu 

atau residual memiliki distribusi 

normal. Model regresi yang baik adalah 

memiliki distribusi data normal atau 

mendekati normal. Cara untuk 

mendeteksi apakah residual 

berdistribusi normal atau tidak dapat 

dilakukan dengan uji statistik non-

parametrik Kolmogorov-Smirnov (K-S) 

test yang terdapat di program SPSS. 

Teknik kolmogorov smirnov memiliki 

kriteria jika signifikansi dibawah 0,05 

maka data tidak berdistribusi normal, 

sedangkan jika signifikansi diatas 0,05 

maka data berdistribusi normal. Selain 

itu analsis grafik adalah salah satu cara 

termudah untuk melihat normalitas 

data dengan cara membandingkan 

antara data observasi dengan distribusi 

yang mendekati distribusi normal 

probability plot. 

 

Berdasarkan uraian di atas berikut 

langkah-langkah Uji Normalitas 

menggunakan SPSS yaitu ; Masukan 

Data → Analyze → Regresion → Linear 

→ Masukan Variabel Independen Ke 

Kolom Independent (S) Dan Dependent 

Ke Kolom Dependent→Save→Ceklis 

Unstandardized → Ok → Analyze → 

Nonparametic Test → Legacy Dialog 

(Sample Ks) → Klik Data Terbaru/Yang 

Paling Bawah Unstandardized 

→Pindah Ke Test Variabel List →OK 

3. Uji Multikolinearitas 

Uji Multikolinearitas yang bertujuan 

untuk menguji apakah model regresi 

ditemukan adanya korelasi antar 

variabel bebas (independent). Model 

regresi yang baik seharusnya tidak 

terjadi korelasi antar variabel 

independen (Ghozali, 2018:107). Jika 

variabel independen saling berkorelasi, 

maka variabel ini tidak orthogonal. 

Untuk mendeteksi ada tidaknya 

multikolinearitas di dalam regresi 

adalah dengan cara melihat besaran dari 

nilai VIF (Variance Inflation Factor) dan 

juga nilai Tolerance. Kedua ukuran ini 

menunjukkan setiap variabel 

independen manakah yang dijelaskan 

oleh variabel independen lainnya. 

dalam pengertian sederhana setiap 

variabel independen menjadi variabel 

dependendan diregres terhadap 

variabel independen lainnya. Tolerance 

mengukur variabilitas variabel terpilih 

yang tidak dijelaskan oleh variabel 

independen lainnya data tersebut di 

nyatakan lolos apabila nilai toleransi 

lebih besar dari 0,10. 

 

Langkah-langkah untuk menghitung 

Uji Multikolinearitas, yaitu: 

Masukan Data → Analyze → Regresion 

→ Masukan Variabel Y Ke Dependen 

Dan Variabel X1 Dan X2 Ke Kolom 

Independen → Pilih Statistik → 

Hilangkan Ceklis Pada Model Bridge 
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Dan Estimate Lalu Ceklis Pada Koleksi 

Diagnostik → Continue → Ok 

4. Uji Heteroskedastisitas 

Uji Heteroskedastisitas bertujuan untuk 

menguji apakah dalam model regresi 

terjadi ketidak samaan variance dari 

residual suatu pengamatan 

kepengamatan yang lain. Jika varians 

dari suatu pengamatan kepengamatan 

yang lain sama maka disebut 

homokedastisitas dan jika varians 

berbeda maka disebut 

heteroskedastisitas. Model regresi yang 

baik adalah yang homoskedastisitas 

atau tidak terjadi heterokedastisitas 

(Ghozali, 2018:137). Untuk mendeteksi 

ada tidaknya heteroskedastisitas dapat 

dilakukan dengan Uji Glejser yaitu 

dengan cara meregresikan nilai absolut 

residual terhadap variabel independen. 

Hipotesis yang digunakan adalah 

sebagai berikut : H0: β1 = 0 {tidak ada 

masalah heteroskedastisitas} H1: β1 ≠ 0 

{ada masalah heteroskedastisitas} Jika 

nilai signifikan antara variabel 

independen dengan absolut residual 

lebih dari 0,05 maka tidak terjadi 

masalah heteroskedastisitas. 

 

Langkah-langkah untuk Uji 

Heteroskedastisitas, yaitu : 

Masukan Data → Klik Analyze → 

Regression → Linear → Masukan 

Variabel Sesuai Kategorinya → Klik 

Plots → SRESID Untuk Di Taruh Ke 

Kotak Y, ZPRED Taruh Di Kotak X → 

Continue → Ok 

 

Metode Pengujian Hipotesis 

Uji hipotesis adalah metode pengambilan 

keputusan yang didasarkan dari analisis 

data, baik dari percobaan yang terkontrol, 

maupun dari observasi (tidak terkontrol). 

untuk memperoleh jawaban dari rumusan 

masalah dan hipotesis penelitian yang telah 

diungkapkan, maka dibutuhkan pengujian 

hipotesis yang sesuai terkait hipotesis yang 

telah dirumuskan. Pengujian hipotesis 

dalam penelitian ini menggunakan 

pengujian hipotesis secara parsial (Uji t). 

1. Uji Koefisien Determinasi (R2) 

Koefisien determinasi (𝑅 2 ) pada 

dasarnya mengukur seberapa jauh 

kemampuan model dalam 

menerangkan variasi variabel 

dependen. Nilai koefisien determinasi 

adalah di antara nol dan satu. Nilai 𝑅 2 

yang kecil memperlihatkan 

kemampuan variabel independen 

dalam menjelaskan variasi variabel 

sangat terbatas. Nilai yang mendekati 

satu berarti variabel-variabel 

independen memberikan hampir semua 

informasi yang diperlukan untuk 

memprediksikan variasi variabel 

dependen. Tetapi penggunaan koefisien 

determinasi tersebut memiliki suatu 

kelemahan, yaitu terdapatnya suatu 

bias terhadap jumlah variabel 

independen yang dimasukkan kedalam 

model. Agar terhindar dari bias 

tersebut, maka digunakan nilai adjusted 

𝑅 2 , dimana nilai adjusted 𝑅 2 mampu 

naik atau turun apabila terjadi 

penambahan satu variabel independen 

(Ghozali, 2018:97). 

 

Bedasarkan penjelasan di atas langkah-

lagkah Uji Koefisien Determinasi 

menggunakan SPSS yaitu : 

Masukan Data → Analyze → Regresion 

→ Linier →Y Ke Dependent Dan X1 Dan 

X2  Ke Independent → OK (Fokus Tabel 

Sunmary) 
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2. Uji Regresi Linier Berganda 

Analisis Regresi Linier Berganda 

merupakan analisis untuk mengetahui 

pengaruh variabel independen yang 

jumlahnya lebih dari satu terhadap satu 

variabel dependen. Model analisis 

regresi linier berganda digunakan 

untuk menjelaskan hubungan dan 

seberapa besar pengaruh masing-

masing variabel independen terhadap 

variabel dependen (Ghazali, 2018:95). 

Berikut adalah persamaan regresi linier 

berganda yang digunakan oleh peneliti 

adalah, sebagai berikut: 

𝑌 = 𝛼 + 𝛽1 𝑋1 + 𝛽2𝑋2 + 𝛽3𝛽3 + 𝑒  

Keterangan : 

a   : Kostanta  

𝑌   : Kinerja Karyawan  

𝛽1 𝑋1 : Sistem Kontrak Kerja 

𝛽2𝑋2  : Motivasi Kerja 

𝑒   : Residual value atau variabel 

lain diluar variabel yang diteliti. 

𝛽1,𝛽2 = Angka arah atau koefisien 

regresi, yang menunjukkan angka 

peningkatan atau penurunan variabel 

dependent yang didasarkan pada 

variabel independent residual value 

atau variabel lain diluar variabel yang 

diteliti. 

 

Bedasarkan penjelasan di atas langkah-

lagkah Uji Regresi Linear Berganda 

dengan menggunakan SPSS yaitu :  

Masukan Data → Analyze → Regression 

→ Linear → Klik Variabel X Ke 

Independent Variabel Y Ke Dependent 

→ Setelah Diketahui Hasilnya Lakukan 

Pengujian Linearitas Dengan Cara 

Kembali Ke Analyze → Regression → 

Linear → Save Centang Unstandardized 

Predicted Value Dan Unstandardized 

Residual → Ok → Pilih Menu Graphs → 

Legacy Dialogs → Scatter/Dot → Pilih 

Simple Scatter → Masukan Variabel 

Unstandardized Residual Sebagai Y 

Dan Unstandardized Predicted Value 

Sebagai X  →OK
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